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1 Introduction to Wavestore Version 6

Welcome to Wavestore Version 6, the latest generation of the award-winning Video Management Software.

This document is an overview of this new software release and provides details of what’s new in version 6
in relation to version 5, as well as considerations for migrating. It is very important to read this document
carefully before considering a migration of an existing Wavestore installation to version 6.

If upgrading within version 6, it is recommended to read the sections for each intermediate release. For
example if upgrading from v6.2 to v6.6, read the sections on versions 6.4 and 6.6.

1.1 Important InformationAboutUpgrading, Licensing, and
Upgrade Bundles

Wavestore uses a system called Upgrade Bundles to allow flexible purchasing of software upgrades. This
system is enforced as of version 6.12.

During the upgrade process, users of particularly old versions of the Wavestore server and new versions of
WaveViewmay see a warning stating...

Warning: You appear to be upgrading to a software versionwhich is later than your UpgradeBun-
dles permit. If you continue with the upgrade the system may become unlicensed. Do you want
to proceed?

If upgrading to version 6.10 or earlier, this will not be an issue. However if upgrading to version 6.12 or later,
it is important to check your Upgrade Bundle version before upgrading. This is displayed on the Server
screen of Setup→ Devices as ”Upgrades to:”. For example:

In this case the latest version which can be upgraded to 6.24. If an attempt is made to upgrade the unit to
6.26 or later, and the warning is ignored, the system will no longer be licensed after the upgrade is com-
pleted.
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To prevent this happening, please do not proceed with the upgrade and contact your supplier to obtain an
Upgrade Bundle.

When upgrading the software, recordings are preserved. However it is important to note that the software
is being continually improved and these improvements might mean that recorded data is not always back-
wards compatible. So for example a storage device formatted for V6.14might not be readable if the system
is downgraded to V6.10, but it will always be forwards compatible so you can upgrade to a later version
without needing to be reformatted.

1.2 CompatibilityBetweenVersion5and6ClientandServers

Note that in this section, ”client” means viewing software such as WaveView, WaveView Mobile, and the
WaveSDK-Active SDK. ”Server” means the Wavestore Recorder.

• Version 6 client software is fully compatible with Version 5 Wavestore servers running version 5.44 or
later.

• Version 5.54 client software and later is partially compatible with Version 6 Wavestore servers. The
limitations are:

– It is not possible to configure a Version 6 server, so the Setupmenu option is disabled.

– It is not possible to save layouts.

– It is not possible to save dewarped views.

• Version 5.52 and earlier of the client software is not compatible with Version 6 servers.

1.3 Considerations for Migrating From Wavestore V5

• The migration process requires a fresh installation of the Version 6 software on to the Wavestore
server. This requires physical access to the Wavestoreand cannot be performed remotely.

• In general, all recordings will be preserved. The exception is that any recordings on the operating
system disk will be lost (this is normally configured as Disk D by default).

• All annotations will be lost whenmigrating from Version 5 to Version 6.

• Support for some older analogue capture devices has been discontinued. See section 1.4.3 - Hard-
ware Support.

• It is advisable to upgrade all remote client software first since the Version 6 clients are compatible
with existing Version 5 servers. See section 1.2 - Compatibility Between Version 5 and 6 Client and
Servers.

• It is advisable to test the client software on any remote client PCs before attempting the migration.
Themethod bywhichWaveView renders video to the display has changed and therefore it is possible
that some client PCs which previously worked with Version 5 might have issues with Version 6. If
testing uncovers any issues, please obtain a system report from theWaveView ”Help | About | System
Info” screen and contact our support teamwith details.
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• When importing a configuration file from a Version 5 server, the network settings will be invalid and
will need to be re-entered manually. If you accidentally import the configuration including the net-
work settings, simply use the Advanced Configuration Editor to delete the [Network_X] sections, re-
boot, then re-enter the network configuration manually.

1.4 Major New Features and Changes in Version 6

1.4.1 New LASS Filesystem

Version 6 has a new filesystem which provides many benefits over the Version 5 equivalent. If you are mi-
grating fromVersion 5, existing recordingswill be preserved, however the benefits of the new filesystemare
not available. The benefits of the new filesystemare only available if you format your storagewhilst running
Version 6.

Here are some of the benefits of the new LASS filesystem in Version 6:

• Support for very large volumes...

– Up to 26 volumes per Wavestore - where a volume is usually a disk, a partition on a disk, or a
RAID array of multiple disks.

– Up to 16 trillion images per volume - that’s approximately 7.4 million days at 25 images per sec-
ond, or the equivalent of 254 cameras for 80 years at 25 images per second! The Version 5 limit
was 589 million images.

– Approximately 16 PetaBytes per volume. Version 5 limit was 20 TebiBytes (Note: a TebiByte is
approximately 1.1 TeraBytes).

– 512 recording tracks per volume. Version 5 limit was 128.

• Improved disk performance

1.4.2 Failover

Version 6 introduces support for N+1 Failover.

The Standby server monitors the logical servers and takes over if any one fails. This leads to a brief in-
terruption in recording and the recording while down is on another server. When the original server comes
back up, it takes over again, and a redirectmechanismmeans the footage recordedby the standbymachine
appears as if it’s on the original server so it’s seamless to users viewing the recordings.

Full documentation is in the Wavestore Manual.

1.4.3 Hardware Support

The followingoldergenerationsofWavestorecompatibleanaloguecapturedevicesareno longer supported:

• The Wavelet Serial Multiplexer

• The Mach series
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• The Warp series

• The Stretch S6 series

Note that you can check which analogue capture cards you have by accessing the server using WaveView
and going to Setup|Devices, then clicking on the appropriate capture device in the device tree on the left.
The Stretch S6 series have a ”Subtype” beginning with ”VRC6”.

1.4.4 Software Installer Changes

The software installer nowworks from USB. Previously it was necessary to burn the ISO to a DVD.

The installer now has amore intelligentmechanism for determining which disk to install to. It will install to
the smallest devicewhich is greater than 26GBandnot the devicewhich the installer is on. i.e. 16GBdevices
will be ignored, 32GB will potentially be used.

Instructions for re-installing the Wavestore software are in the full manual which is provided on the DVD or
ISO file.

1.4.5 Licensing Changes

• New BASE licence provides maximum 2 simultaneous users.

• Active Directory support is now licence controlled.

• Integration modules are now individually licensed.
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2 Version 6.18.27 Changes

2.1 Server Changes

• Updated Italian translations

• Added new GET_RECORDINGS command to allow the ActiveX SDK to request a list of recording start
and end times of a track

• Improved handling where jumping time backwards then rebooting could cause time jump to not
work. Note that it’s still advisable not to reboot for awhile after jumping timebackwards. Themanual
describes the correct process in detail

• Improved upgrademechanism to better handle low disk space

• WS-Discovery protocol is now restricted to local networks

• Fixed some H.265 capture issues

• Fixed an issue where HikVision encoders weren’t correctly identified as encoders

• Fixed incorrect handling of permitted cameras for IDs 29+

• Improved handling of some cases of faulty camera streams

• Fixedan issuewith switchingVirtual SpotMonitor oneventswhenusingnewsub-stream functionality

• Fixed an issue where AAC audio could fail to stream

• Fixed an issue which could cause multicast capture to fail

• Fixed an issue with licensing multiple EMS (Encoder/Multi-Sensor) devices

• Fixed an issue with audio lip-sync

• Fixed an issue with audio failing to capture from somemisbehaving devices

• LSI RAID card ”patrol reads” now disabled to reduce disk wear

• Fixed support for Supermicro-X11SSH-LN4Fmotherboard with no extenal disk enclosure

2.2 WaveView Changes

• Updated Italian translations

• Improved warning message shown when large time changes occur in Time & Region setup screen
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3 Version 6.18.15 Changes

3.1 Server Changes

• Added support for recording to files and improved NFS storage via new LASS-LIFT technology

• Added new ”Auto+” encoding which will favour H.265 for video and AAC for audio. Existing ”Auto”
encoding will maintain H.264 and G.711

• Added support for restreaming H.265 over RTSP

• Added support for audio-only IP devices

• Added support for AAC Audio including configuring it in Auto mode where available

• Added lots of performance statistics gathering which can be downloaded as CSV

• Added support for triple streaming from IP cameras

• Added support for talkback via Axis VAPIX

• Added support for Moxa alarm boards

• Improved camera error reporting

• Added extra ”Unlicensed” state for disks (for when a configured storage feature isn’t available due to
licence restrictions)

• Addedsupport forONVIFPTZPresetevents (PTZPresetInvoked, PTZPresetReached, PTZPresetAborted,
PTZPresetLeft)

• Added new command for ”Execute Command” to download config backup file: idownload-config

• File capture type now supported with new Camera Groups system

• Added log rotation rule for LSI MegaRAID log file (MegaSAS.log) to avoid filling OS disk

• Addedmore event handling for Avigilon, Dahua, Hikvision and Mobotix

• Added sensors support for Gigabyte H87M-HD3, and Supermicro X11SCH-LN4Fmotherboards

• Faster camera startup

• Addednewcommand for ”Execute Command” to list anddelete locked recordings: getlock and clear-
lock

• Various improvements to TCP and HTTP alarm output mechanism

• IPv6 support for SNMP, VAPIX, and Failover
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• Removed 5 second startup kernel selection for UEFI systems

• AMD graphics drivers changed to use ”auto” instead of attempting to install old proprietary driver
which would fail

• Fixed talkback for Mobotix cameras when using Auto or ONVIF mode.

• Fixed some issues playing audio clips on event

• Fixed some rare issues with Pullpoint event subscriptions

• Fixed issue with potential latency on Virtual Spot Monitors

• Fixed ”restore configuration backup” option in maint menu

• Fixed issue where PTZ on Uniview cameras sometimes wouldn’t stop

3.2 WaveView Changes

• Added support for multiple Video Display Areas

• Added a waveform visual representation for audio

• Added support for PTZ control via mouse within Video Display

• Added support for audio-only and talkback-only IP devices

• Added ability to automatically start Layout Sequence on login

• Added support for triple streamed cameras

• Added a ”Window”menu which can be used to show/hide the dock widgets in the Main screen

• Added Encoding and Audio Encoding settings to Camera setup, including Auto+ mode

• Added extra functionality to DCZ joystick (Clear Layout, Wipe, Wash, Next Display Area, Select All)

• Enhanced options when importing server configuration file (can ignore importing network settings,
licence, disk assignments, and systemmonitoring settings)

• Support for multi-streaming to Virtual Spot Monitors

• Added support for Unlicensed and Foreign statuses in Storage setup screen

• Improved camera error reporting - clearer messages

• Improved performance of transcoded exports

• Fixed issue which could cause slow update of setup screens after visiting Cameras setup screen

• Fixed issue where talkback couldn’t be turned off after visiting the setup screens

• Fixed issue with Free layouts in Layout Sequence not displaying correctly when full screen

• Fixed several issues with the event filter preferences when receiving custom events

• Fixed several issues with configuring integration modules in I/O Devices setup screen

• Fixed some issues with privacy andmotionmasks relating to dual/triple streaming

• Fixed erroneous DHCP warning message for disabled network interfaces during Failover setup
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• Fixed issue where export directory wasn’t automatically created by Waveview if non-existent

• Fixed issue where progress information wasn’t shown for transcoded exports

• Fixed issue with playing through recordings with gaps in audio stream

3.3 WaveSDK ActiveX SDK Changes

• Added facillity for getting recording index data for timeline

• Added facility for opening WSB archives

• Addedmouse double-click events

• Added drag and drop events

• Added slow playback functionality (x0.1 to x2.0 speed)

• Added snapshot function to WVideoDisplayWidget

• Example application now shows how to take snapshots

• Example application now shows how to do Live Recording

• New output window to showmouse events

3.4 More Information
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4 Version 6.16.66 Changes

4.1 Server Changes

• Fixed problemwith NVIDIA drivers - important for PT-Series and PD-Series owners

• Correcteddrivenumbering forAIC-12G-4U24SAS3EOBenclosurewithSupermicro-X11SSH-LN4Fmoth-
erboard

12



5 Version 6.16.62 Changes

Version 6.16 is a new releasing containing many new features. There is also a major update to the under-
lying operating system in order to provide support for the latest hardware. Note that the OS updates are
only provided when installing version 6.16 afresh. Wavestore systems installed with earlier versions and
upgraded to v6.16 will remain on the existing underlying Operating System. This is not a problem as these
updates are only required for newer hardware platforms.

5.1 Server Changes

• Added support for H.265 video (note that RTSP re-streaming of H.265 is not yet supported).

• Added support for IPv6. See section 5.4.4 - IPv6 Support.

• Added support for separate licensing of encoder andmulti-sensor camera channels. See section 5.4.1
- Separate licensing of encoder andmulti-sensor cameras for more information.

• New Central Event Server feature allowing forwarding of events from servers in a group to a central
server where rules can be applied. See section 5.4.2 - Central Event Server for more information.

• Support for installation to UEFI systems.

• Major update of OS kernel and other OS packages.

• Added support for whitelist of permitted cameras for users, in addition to the existing blacklist.

• Added support for ONVIF Media2 Service including camera configuration.

• Improved ONVIF camera configuration mechanism to give faster startup and wider compatibility, in-
cluding allowing automatic camera configuration with Failover.

• Improved fault reporting policy in the System Log and Event Stream

• Improved camera disconnect messages.

• Added facility to device database for selecting H.264 Profiles.

• Added facility to device database for enabling or disabling Digest Authentication.

• Added new ”Failover” event cause.

• Added network problem detection for camera streaming.

• When a camera is being reconfigured the old stream now continues until the new one is ready. This
reconfiguration is signalled to clients.
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• Support for Virtual Spot Monitors to switch to low-resolution stream.

• Support for Virtual Spot Monitor Trigger Rollover. See section 5.4.3 - Virtual Spot Monitor Trigger
Rollover for more information.

• Added Axis event causes: IO, Signal Loss, Global Scene Change, Image Too Dark, Tampering, Virtual
Input.

• AddedHanwhaevent causes: Appear, Disappear, Loitering, Virtual line, Enter/Exit, DefocusDetection,
Fog, Motion Detection, Tampering, Face Detection, Audio Detection.

• Added Mobotix event causes: Motion events.

• Added support for MODBUS over TCP such as Advantech ADAM

• Added 4K to list of default resolutions.

• Added setting to determine whether internal or external motion events should be used.

• Improved logging of disk performance issues.

• Improved logging of SSDWear.

• Improved logging of ONVIF camera configuration.

• Improved handling for talkback when enabled but not supported by the camera.

• Better management and reporting of RAM usage.

• Better logging of received events.

• Support for Video Guard/SIRA Specification.

• Many improvements to camera compatibility.

• Fixed issue with enclosure detection for Supermicro devices.

• Fixed issuewhereRecording indicator could remain activewhen recording to failedHyperRAIDarrays.

• Fixed issue with syncing to NTP sources via hostname.

• Fixed ’Hue’ setting on Stretch analogue capture cards.

• Fixed issue where Login Denied event could trigger event action twice.

• Fixed issue where disabled cameras could raise Faults.

• Fixed issue with streaming MPEG-4 over RTSP.

• Fixed issue with password synchronisation between servers in a Failover group.

5.2 WaveView Changes

• Added support for H.265 video.

• Added support for IPv6.

• Added support for special licensing of encoder and multi-sensor camera channels. See section 5.4.1
- Separate licensing of encoder andmulti-sensor cameras for more information.
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• Added support for whitelist/blacklist of permitted cameras for users.

• Added new Shared Layouts facility. Layouts created by one user can be shared with other users.

• AddednewLayout Sequences facility. Allows showing layouts for a configurableperiodof timebefore
switching to another layout, repeated in a loop.

• Improved UI scaling for high DPI displays.

• Added ability to select joystick to use in case multiple devices detected.

• Removed unnecessary steps when switching to Dewarpmode.

• Further improvements to new Cameras setup screen.

• Added Volume and Input Selection (line or mic) controls for audio channels.

• Added ”Camera Setup Page” browser shortcut to the Cameras setup screen.

• Added error highlighting to the Cameras setup screen.

• Added 4K to list of preset resolutions.

• New ”Main View” setup screen which contains the existing Channel Groups and Metadata Display
setup screens, as well as a new setup screen for Layout Sequences.

• New setup screens for Advantech ADAM and Moxa I/O devices.

• New setup screen for SNMP configuration.

• Added integration event facility for launching cameras from different times and servers in the server
group.

• Increased default log size to 100 MB.

• Disk Setup Screen now indicates when disks are in Readonly mode.

• Encryption Setup Screen now shows public encryption key.

• Added a subtitle entry that indicates whether the camera is currently being reconfigured.

• Subtitles now show bitrate in bits/s instead of Bytes/s by default.

• New preference ”Gap Threshold” to determine when to skip areas with no recordings.

• Improved ”Execute Command”window to be faster, always append output to end, and auto-scroll to
end.

• Improved handling of automatic user logoff.

• Improved speed and fixed some problems with the System Log window.

• Fixed issues with WSB exports where invalid characters in camera names or filename could cause
problems playing back.

• Fixed issue where properties for Custom Events would not be applied in Events Preferences.

• Fixed issue where initial dewarping view could be corrupted.

• Fixed several issues with transcoded exports including glitchy audio with mp4 andmov.

• Fixed issue where Global Talkback button didn’t work reliably.

• Fixed issue where maximum sensitivity for motion or smart search would always detect motion.
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• Fixed tab order in Network setup screen.

• Fixed issue where digital inputs could be numbered incorrectly.

• Limited analogue spot monitor configuration to only the allow analogue cameras.

5.3 WaveSDK ActiveX SDK Changes

• Added support for H.265 video.

• Added support for IPv6.

• Resolved limitation where it was not possible to export from multiple servers (note that for WSB ex-
ports, only one server group is supported).

5.4 More Information

5.4.1 Separate licensing of encoder and multi-sensor cameras

Version 6.16 introduces a new licensing option for encoders and multi-sensor cameras to lower the cost of
deploying systems that utilise these technologies. The new Encoder and Multi-Sensor (EMS) licence type
is available at all levels (BASE, PREMIUM, ENTERPRISE and ULTIMATE) which licenses the entire encoder or
multi-sensor camera instead of each individual channel.

EMS licences can bemixed andmatched as necessary with individual IP channel licenses across a solution.
This means that Wavestore customers who wish to continue using legacy analogue cameras, now only re-
quire a single EMS licence inorder tousea16-channel standarddefinitionencoder, a 4-channel AHD/TVI/CVI
encoder or a multi-sensor camera from a host of world leading brands.

Note that old style licences which do not have a separate field for ”permitted EMS devices” will continue to
work as in previous versions. That is, each channel on the device requires one ”permitted IP channel”.

For new licences supplied with one or more ”permitted EMS devices”, any EMS device configured on the
systemwill only be checked against the permitted number of EMS devices andwon’t fall back to using ”per-
mitted IP channels”.

5.4.2 Central Event Server

The Central Event Server (CES) is a powerful and extensible feature of Wavestore which allows all (or some)
events from the Live Event stream on a number of Wavestore servers to be forwarded to a central server
which we call the ”Central Event Server” or ”CES”, which can process the events.

The Central Event Server is just one of the Wavestore servers in the Server Group, it does not require any
special hardware, just a suitably licensed system.

For example: consider a systemwith 5Wavestore servers all in one Server Group. Server 1 can be set as the
Central Event Server, and this will pull events from the other servers in the group automatically (providing
the CES has been enabled).
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There are a number of ways of configuring it, depending on requirements. Usually it is used to aggregate
events from sources on different servers. This will generally be required by certain IntegrationModules and
configuration instructionswill be providedwith the IntegrationModule. By default the Central Event Server
functionality is disabled.

Currently there is no UI for configuring this, but the Configuration Editor can be used to enable it with guid-
ance from our support team. A full configuration UI will come in the next software release.

5.4.3 Virtual Spot Monitor Trigger Rollover

Up to version 6.14 the Virtual Spot Monitor feature allows events to cause cameras to be switched to an-
other camera feed. For example camera 100 might be a Virtual Spot Monitor and cameras 1 to 50 might be
configured to route their video to camera 100 when motion occurs. This new Rollover facility allows these
events to be passed to ”free” virtual spotmonitors if the first one is busy. For example if camera 100 is show-
ing camera 1 due tomotion, thenmotion occurs on camera 2, it can ”rollover” to camera 101 (another spot
monitor).

Currently there is no UI for configuring this, but the Configuration Editor can be used to enable it with guid-
ance from our support team. A full configuration UI will come in the next software release.

5.4.4 IPv6 Support

In version 6.16, support for IPv6 is introduced. However a few less commonly used features do not fully
support IPv6 as yet. These will be added in future releases. The not-yet-supported with IPv6 features:

• Axis I/O Devices using the VAPIX interface such as the Axis P8221

• SNMP v2c Traps (for sending event notifications)

• Failover

• Capture of multicast streams
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6 Version 6.14 Changes

Version 6.14 is a major new release strongly influenced by customer feedback. The major areas of focus
were ease-of-setup and delivering new improved storage technologies, although many other changes and
improvements were also developed.

Be sure to read section 6.4.1 - Important Information about New Configuration Format before upgrading.

6.1 Server Changes

• NewHyperRAID, HyperRAID Plus, and EcoStore technologies - see section 6.4.2 - HyperRAID and Eco-
Store

• Support for recording to disks in sequence

• New facility to identify Faulty and Spun-down Hard Drives via SAS Sideband LEDs

• New facility to identify disks by Drive Bay numbers for supported enclosures

• Improved events on HDD Failure for HyperRAID and single drives

• Support for Camera Groups

• Improved Camera Discovery mechanism

• Improved detection and configuration of multi-lens cameras and encoders

• Support for HTTP Digest authentication

• Improved licensing for integration modules

• Improvements to network licensing to allow easier virtual machine cloning

• PTZ for ONVIF devices now automatically enabled if supported

• New recording modes including facility for scheduled Permanent Recording and Event Recording on
the same track

• Ability to Boost framerate on schedule

• Smart Search andmotionmask improvements

• Support for internal motion detection for IP cameras - see section 6.4.3 - Internal Motion Detection -
Supported Cameras for requirements.

• Support for Audio and Talkback on same channel as video, rather than as a separate channel
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• Nightly logs now report range of recording, not just earliest

• Ability to remotely view OS kernel log

• Ability to show blank image when Virtual Spot Monitor channel has no camera assigned

• Support for SNMP v2c protocol including for SNMP Traps

• Added Wavestore RTSP type to RTSP profile list

• Better text provided for ONVIF flags options

• New facility to auto-backup configuration weekly and when a configuration is loaded

• Email video clip script can now take container format as an option

• Added generic multi-channel Axis encoder request strings

• Added Dedicated Micros HTTP request string

• NewMaintenance Menu option to force monitor resolution for client on server

• Added wear monitoring for Supermicro SATADOM SSD

• Sensor and SSD-monitoring configuration moved to separate ”wavestore-hardware” package to al-
low easier backporting

• Disabled motherboard audio in hardware detection by default, optionally enable

• Support for auto-focus via ONVIF and other PTZ improvements

• Improvedhandlingof ResolutionandEncoding settingswhenusing ”Auto-configure camera streams”

• Improved disk fault reporting

• Fixed issue where errors with emailing video clips could be re-loggedmultiple times

• Fixed issue with emailing to more than 10 potential recipients

• Fixed issue with timestamps in non-UTC time zones when sending emails

• Fixed issue where server didn’t unsubscribe from ONVIF PullPoint

• Fixed several issues relating to failover and failover recovery

• Various ONVIF and RTSP streaming improvements and fixes

• Fixed USB ISO ”Recovery Mode”

• Fixed some cases where server unnecessarily requested restart

• Fixed issue with preserving server license when defaulting config through ”maint” menu

6.2 WaveView Changes

• New Simpler Camera Setup

– ”All tracks” settings

– ”Auto” type
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– Automatically enable PTZ for ONVIF devices if supported (Client)

– Audio and Talkback on same channel as video

– HD Options in Resolution Dropdown field

– Implement client polling for network discovery of ONVIF cameras

• New Server Setup Screen containing submenus with formerly top-level setup screens

• New Licence screen and support for new licence levels

• Opening associated cameras from event/metadata performs best fit

• Smart search andmotionmask improvements

• Disk Setup Screen updates for HyperRAID and EcoStore, plus ”Flash Good Drives” facility

• Export improvements including...

– Tidiedup list of encoders for transcoded exports, removingold codecswhichdon’t functionwell
and fixing many others

– Find screen no longer has export toolbar as the Find screen flags should be used instead

– Improved handling of ’from’ and ’to’ flags to ensure they are correct

– Fixed issue where linked audio channels > 128 wouldn’t work in WSB export

– Fixed issue exporting when audio is continuous but video has gaps

– Fixed issue where exported WSB export could have an inactivity logout timer if the user that
made the export had this configured

– Other general improvements and fixes

• Preset and Tour support for joysticks/keyboards

• Added support for Videotec DCZ keyboard

• Enhanced quick annotation time selection

• Fixedmajor freezing on live streaming (client)

• Added GUI buttons for auto-iris and auto-focus

• Metadata improvements

– Movedmetadata visualisation settings to the server configuration file

– Point of Sale and overlay console visualisation now start streaming automatically

• Facility to list and restored backed up configs

• User’s layouts are now deleted with the user

• Removed Execute Command function from Config Editor screen as it’s available under Tools

• Added support for ”force failover” event action

• Better descriptions for certain event types, e.g. ”Generic Fault” now shows ”Fault (see System Log)”

• Custom event causes now available on Events Preferences and Event Search

• Added support for integration with KeyScan
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• Fixed clicking sound on audio playback

• Fixed some issues with ”Live Buffering” mode which could cause spinning wheel

• Re-addedmechanism for de-highlighting selected items in live event stream

• Fixed issuewhere client could fail to automatically reconnect to serverwhen ”TooManyConnections”
error occurs

• Improved Linux packaging to fix issues deploying to some Linux distributions

• Fixed issuewhere the camerawould become smaller when the video streamhas different resolutions
over time

• Fixed issue where map images with spaces in filename wouldn’t upload

6.3 WaveSDK ActiveX SDK Changes

• Support for auto-iris and auto-focus

• Support for audio and talkback on same channel as video

• Some export containers and codecs have been removed due to lack of reliable operation. Please
check the new list using the API as described in the ActiveXmanual or contact our SDK Support team
for more information

• The PtzfEnabled property is now deprecated. See ActiveX manual for details

• This release is ABI compatible with the previous version 6.12

6.4 More Information

6.4.1 Important Information about New Configuration Format

One of themain focal points of version 6.14 was to simplify ease-of-setup. This has been achieved by intro-
ducing several new features including Camera Groups and the ”Auto” group typewhich will try to automat-
ically detect the camera type and set it up with sensible defaults without requiring manual settings.

One effect of these changes is that the configuration format written by WaveView version 6.14 is new, and
thereforecannotbeunderstoodbyoldversionsof theWavestoreclient software, includingWaveView,WaveSDK-
ActiveX, andWaveViewMobile. Therefore any client devices needing to access a v6.14 server configuredwith
these new facilities need to be up-to-date. If using the on-server client display, this does not restart auto-
matically, so a reboot is recommended.

Thenewversion 1.14WaveViewMobile clientwill be required for any servers configuredwith 6.14. However
it’s important to note that this version does not support Android 4.4.4 (KitKat) or below. Android 5.0+ is
required. This is due to the manufacturer dropping support for these older versions.

Also note that exports are backwards compatible but not forwards compatible, meaning that exportsmade
in v6.14 can’t be played back in olderWaveView versions, but exportsmade in olderWaveView versions can
be played by v6.14.
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The version 6.14 client is compatible with servers as far back as version 5.54 and can be used to configure
those servers, however some of the new setup conveniences such as ”Auto”mode and Camera Groupsmay
not be available.

Upon upgrading to version 6.14, the server automatically makes a backup of the configuration. Should
anything gowrong, this backup can be quickly restored by going to View→ Setup→ Server→Configuration
Editor→ Load Backup.

Whena server is upgraded to version6.14, the server’s configuration is not changedautomatically. However
the first time a v6.14 client is used to make changes in the Cameras setup screen, these settings will be
written back in the new format.

Note that the default recording setting in version 6.14 is to record for an absolutemaximumof the specified
days. Previously the default behaviour was to record for as long as possible, using the configured days as
a guideline of how to balance the available space between the various recording tracks. It is important to
check that these new default settings are desirable and change them if not.

To summarise these points:

• Version 6.14 can read and write to any server version back as far as version 5.54.

• If using v6.14 or later, any settingsmade in the Cameras setup screenwill be in the new format, which
can’t be understood by older client versions.

• Exportsmadebyv6.14afterupdating to thenewconfiguration formatcan’tbe readbyolderWaveView
clients.

• Upon upgrading to v6.14, the configuration is automatically backed up to allow rolling back if neces-
sary.

• The newWaveView Mobile only supports Android v5.0 and later.

• If using the on-server client display, a reboot is recommended.

• Thedefault recording setting in version6.14 isnowto record for anabsolutemaximumof the specified
days.

6.4.2 HyperRAID and EcoStore

HyperRAID™ is a new technology unique toWavestore providing cost-effective redundancy in storage arrays
whilst performing faster than traditionalRAIDwithout requiringa traditionalhardwareRAIDcard tooperate.
This technology is compatible with a wide range of Wavestore servers and various disk controllers. Full
details can be obtained upon request.

Along with HyperRAID™, version 6.14 adds the ability to record tomultiple ’disk groups’ in sequence. A disk
groupcouldbea singlediskor aHyperRAIDarray. Thesediskgroupscan thenbespundown, orde-activated
when idle, to save energy consumption and heat output. The combination of these technologies is known
as EcoStore®.

EcoStore is a registered trademark of Wavestore Global Limited.
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6.4.3 Internal Motion Detection - Supported Cameras

The new internal motion detection is designed to work for ONVIF Profile S compliant cameras which are
capable of transmitting a JPEG stream of 648x648 pixels or less. Note that this JPEG stream is used as an
additional stream from the camera on top of any existing configured streams, so the cameramust be capa-
ble of this.

The JPEG stream is a low resolution stream at 4 frames per second and so some extra bandwidth is used for
this.

This functionality is described in detail in the section ”Configuring Motion Detect Recording” of the Wave-
store manual.
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7 Version 6.12 Changes

7.1 Server Changes

• Upgrade Bundles are now enforced. IMPORTANT - please read section 1.1 - Important Information
About Upgrading, Licensing, and Upgrade Bundles before upgrading.

• Support for capture and record of multicast streams from ONVIF devices.

• Support for connecting to ONVIF devices via TLS/SSL.

• Support for Recording Lock facility (was available in version 5, now added to version 6).

• New Executable Command to reboot the camera.

• Various I/O improvements for 3rd party integrations.

• Improved logging in RTSP Server.

• Improvements to Network Licensing mechanism include better error messages.

• New command to query status of event causes, used primarily by Maps in WaveView.

• Email sending mechanism now has a new throttling mechanism.

• Increased size of root partition for new installs from6GB to 10GB. Overall requirement for systemdisk
increases from around 17GB to 21GB. Should still fit easily on even the smallest SSDs.

• General improvements to IP camera compatibility.

• Someminor improvements relating to failover.

• General improvements relating to sending emails.

• Fixed issue where ”force user to change password on next login” wouldn’t always work.

• Fixed issue where ”Shutdown System” via remote client wouldn’t successfully shut down A-Series.

• Fixed problemwith PTZ control when using RTSP dual streaming.

• Fixed problemwith RTSP re-streaming when capturing with RTSP dual streaming.

• Several fixes relating to Virtual Spot Monitor sequences.
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7.2 WaveView Changes

• Various map improvements including...

– Map configuration and images are now saved on server instead of client, easier system setup.

– Maps now show current alarm status on entry.

– Maps edit mode nowmoved to the setup screens.

– Maps now correctly handle Digital Inputs within server groups.

• New Status Summary Screen allowing quick view of all cameras in the server group.

• Various improvements and fixes relating to metadata visualisations including...

– Metadatavisualisationsarenowassociatedwithcamerasvia thesetupscreen. Noneed tochoose
each time one is opened.

– ”In-display” visualisations such as Text Overlay are now opened automatically.

• For ONVIF stream settings, a custom resolution can now be entered.

• Various improvements to the File Manager.

• Various improvements to allow better integration of 3rd party systems such as ANPR/LPR.

• Whenmaximising a camera from a layout it now automatically switches to high resolution stream.

• Enforcement of Upgrade Bundles including checking and warning when appropriate.

• Re-added concept of ”viewed” events in live event stream (was in version 5 but not version 6 until
now).

• Fixes and improvements to Virtual Spot Monitors including...

– Dwell time now defaults to 5 seconds instead of 1.

– Number of Virtual Spot Monitors channels limited to 2, otherwise undesirable issuesmay occur.

• Setup screen support for ONVIF Multicast devices.

• ”Server awaiting restart” now shown on setup status bar to make it more obvious.

• The behaviours of the various ”Tools” windows are nowmore consistent.

• The ”auto control toolbar” functionality is now removed as it wasn’t predictable. Can still be used
manually.

• Adding cameras to a free layout now tiles displays (a little downand to the right compared toprevious
camera).

• New preference to enable/disable ”Lower resolution threshold when panning”.

• Manually triggered events from Event Rule screen (Test On / Test Off) now logged to System Log.

• Annotation storage settings now configurable.

• Old limit of 255 users increased to 9,999.

• Improved UI for ”Flash Good Drives” function.
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• Improved joystick Shuttle and Jog functions on Linux, to match Windows functionality.

• Email Server setup screen improvements to support new email throttling mechanism.

• Improved decoders and logging of decoding issues.

• Fixed issue where streams with changing resolutions could cause display to get smaller each time.

• Fixed issues with duplicated event causes when adding multiple actions.

• Fixed several issues with adding new I/O devices for integration modules.

• Fixed issue where tooltip text on Windows was hard to read.

• Fixed issue where dismantling server group could leave old erroneous configuration.

• Fixed issue where setup screens wouldn’t work on some laptops with new NVIDIA drivers.

• Fixed issue where schedule setup would not allow continous overnight period.

• Fixed issue where opening password-protected WSB export taken from server group could cause
password prompt to appear once per server.

7.3 WaveSDK ActiveX SDK Changes

• IMPORTANT - The ActiveX SDK now requires version 5 or version 6.12 and above, earlier version 6
servers not supported.

• Added support for encrypted recordings.

• Added support for licensed integration modules

• Fixed issue where the ActiveX DLL version number was incorrect

• Various other fixes and improvements. See the WaveSDK ActiveX Reference Guide for more informa-
tion.
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8 Version 6.10 Changes

8.1 Server Changes

• Major update to the operating system. IMPORTANT: This can affect the graphical interface on the
Wavestore because of driver changes, see Changes relating to graphics drivers for more information.

• Performance improvements relating to live streaming

• New ”Recording less than intended” event cause

• Many improvements to ONVIF camera compatibility and features such as automatic camera configu-
ration, audio and talkback, multi-streaming, and device discovery. Includes improved error logging.

• Fewer IP camera setting changes require server restart

• RAID Faults now trigger Disk Fault event cause

• Reboots caused by watchdog are now logged as a fault after system comes back

• Allow suppression of Pullpoint messages from cameras in Live Event Stream

• Commands for jumping time forwards and jumping back with deletion of footage

• Ability to do graphics driver install and uninstall remotely

• Pre-event framerate boost now fully supported in V6 LASS file format.

• Upgraded proprietary NVIDIA and AMD graphics drivers

• Significant improvements in Axis-HTTP PTZ protocol

• Nightly reports are now output at midnight localtime, not UTC

• Various improvements to allow integrations with more 3rd party devices

• Various improvements relating to handling of LSI RAID cards

• Various failover improvements

• Fixed issue where fault messages could occur for disabled IP audio channels

• Fixed potential problems switch to and from bonded network interfaces

• Note: Software Support Agreements are not enforced in this version. They will apply to v6.10.
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8.2 WaveView Changes

• Changes to layout double-click mode - see Changes to behaviour of double-clicking displays

• ONVIF Camera Setup - ”Allow Wavestore to configure streams” and ”Enable PullPoint” now enabled
by default for easier setup.

• New Error Codes for video displays to show camera status more clearly

• Added support for new ’Recording less than intended’ event cause

• Various minor UI improvements including:

– Tidied upmain screen dock widget containing playback, event, and PTZ controls

– Thinner border for selected video displays

– Clearer icons for alarms in map viewer

• Various improvements to joystick PTZ control

• Various fixes and improvements relating to Disks Setup and LSI RAID cards

• Exports are now correctly logged to system log

• Server UID is nowwritten in client log upon connection

• Improvements to smoothness of video streaming over busy networks

• Various non-relevant screens are now disabled when viewing WSB export

• Front screen now remembers folded/unfolded state of dewarped view(s)

• Updated Immervision-enables dewarping library

• Fixed potential issues with configuration sync when network connection to server lost

• Fixed a rare and somewhat random crash which could occur whenmanipulating camera positions in
layouts

• Fixed setup screen for analogue audio and volume level control

• Fixed some issues leaving Find screen with the on-server WaveView client

• Fixed some issues with configuring Virtual Spot Monitors

• Fixed issuewhereplayback controlswouldn’t alwayswork on selected cameraswhendisplayingmul-
tiple cameras

• Various improvements to export and playback of WSB files from server groups

• Many other minor bug fixes and improvements

8.3 WaveSDK ActiveX SDK Changes

A major new revision of the WaveSDK-ActiveX SDK is available in 6.10. The underlying components have
been revamped with enhanced performance, modern architecture and improved flexibility. Keeping up
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with the best development practice the API is nowmore consistent and easy to use. By improving the exam-
ple code and including small snippets in the documentation the developers can quickly get up and running
with the latest SDK. Several new features are available in the new release. The core features included in the
SDK are listed below.

• Connect to various Wavestore servers.

• Wavestore server management routines such as restart process and reboot and shutdown server.

• Retrieve a list of cameras and audio inputs and outputs, configured on each server.

• Full playback control (e.g. live, play, fast-forward, rewind, frame-step back, frame-step forward, jump
to beginning and jump to end of video)

• Full PTZ control (e.g. vector PTZ commands, focus, iris, wash, wipe, lamp, recall tours and presets.)

• Search in the pre-recorded video based on date and time.

• Receive information when the servers are changed (e.g. lost connection, reconnected, configuration
changed, other changes or errors).

• Stream video to an ActiveX control or receive raw decoded data.

• Dual Streaming capability, i.e. switch between a high or low resolution stream.

• Additional functions are available for the video streaming ActiveX control:

– Display a subtitle with image information overlaid on the stream.

– Zoom in and out around a coordinate in the stream.

– Keep aspect ratio or fill the whole control.

– Receive mouse and wheel event.

• Bidirectional audio (audio and talkback).

– Retrieve decoded audio data and play it through a provided audio player.

– Input rawdata to a talkback channel either throughanaudio file or using theprovided recording
device class.

• Create annotations to identify events.

• Receive events from the server. Each event includes:

– The date and time of when the event occurred.

– The cause of the event.

– Other information such as the source name, server name and additional text related to the spe-
cific cause of the event.

• Trigger rules (event causes/actions) configured on the server.

• Export recordings from different tracks to different formats (both transcoding as well as to our own
.wsb format).
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8.3.1 SDK Changes versus Version 5

• Dewarping is no longer supported.

• Encrypted recordings are no longer supported.

• Eventnotificationsystemisno longer supported. All theeventsarenowautomaticallypassed through
to the ActiveX SDK.

Note that if the above features are required, the version 5.54 WaveSDK-ActiveX SDK can still be used with
version 6 servers. It is planned that features missing in the new SDK will be added within the next few
releases, in an improved form.

8.4 More Information

8.4.1 Changes to behaviour of double-clicking displays

When viewing a multi-camera layout in previous versions of WaveView, the behaviour was as follows:

• Double-clicking a camerawould enter a ”solomode”, showing just that camera, yet leaving the layout
in its previous state, e.g. ”3x3”

• Double-clicking the camera again would make that camera full-screen

• Double-clicking again would return to the original layout

This concept of the ”solo mode” has now been removed as it could result in unexpected behaviour in cer-
tain circumstances. As of version 6.10 a double-click of a camera in a layout will full-screen it, and another
double-click will return to the layout.

If it is desired to solo a camera, simply select the camera and change to a 1-way layout.

8.4.2 Changes relating to graphics drivers

When the Wavestore is first installed, if it contains an NVIDIA or AMD (formerly ATI) graphics card, the pro-
prietary graphics drivers for the manufacturer would be recommended for install. If factory supplied, this
option would be accepted.

When upgrading to v6.10, the old graphics drivers are incompatible with the latest operating system and
will be automatically removed. Normally this won’t cause an issue but it’s usually recommended to install
the latest proprietary drivers.

A newmenu option is available so that this can be performed locally or remotely. Here is how:

• Using WaveView, log in to the server

• Go to Tools→ Server Maintenance

• Choose Configure server graphics drivers

• Choose Configure Drivers

• Choose the appropriate option to install proprietary drivers.
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If performing this operation remotely it’s advisable to have someone available to check that the graphical
interface is working after any change. A reboot is required after installing or removing proprietary drivers.
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9 Version 6.8.78 Changes

9.1 Server Changes

• New facility to record any track to two disks simultaneously

• Resolved issue where dual-streaming would not always work for secondary stream

• Support for pre-event framerate boost

• Fixed issue with failover redirection of recordings

• Fixed issue with failover incorrect handling of multiple and bonded network interfaces

• Fixed issue where faulty cameras could cause ”Too Many Open Handles” error in server

• Fixed issue with ’slewtimefast’ command for clock correction

• Improved logging for disk performance

9.2 WaveView Changes

• New Map Edit permission per user

• Support for new server Disk2 parameter, to record to two disks simultaneously

• Fixed issue with opening WSB exports of multiple cameras frommultiple servers

• Fixed issue with opening very long WSB exports split across multiple files

• Fixed issue where PTZ Lamps, Washers, and Wipers would not latch on
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10 Version 6.8.22 Changes

10.1 Server Changes

• Support for virtual machines via hardware dongle

• Support for network licences

• New facilities for copyingdatabetweendisks andWavestores (currently advanced feature for useonly
guided by Wavestore technical support)

• Disk throughput performance improvements

• Improvements to performance of logging facilities

• Option to reverse PTZ tilt operations

• Camera Database Update: Motion recording using ONVIF Pullpoint from Samsung SNV-6013 camera
reported to stop working after server upgrade from V6.4 to V6.6

• Various failover improvements

• Improved handling of LSI MegaRAID cards

• Fixed issue with switching off output of AXIS P8221 device

• Improved tools for slewing server clock when incorrect time is set up but recordings need to be pre-
served

• Fixed issue which could cause log partition on server to fill up

• Fixed issue which could cause events to be triggered toomany times

10.2 WaveView Changes

• Several improvements to main screen Device Tree including...

– Ability to search/filter items in the tree

– Folded/unfolded states of servers and cameras are remembered

– Settings are stored in local preferences so remembered each time WaveView runs

– Ability to expand all or collapse all items

– Performance improvements when connecting to large server groups
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• Upgraded to latest Ampleye SDK

• Improved UI for setting dewarped views (Oncam and Immervision)

• Local preference to hide ”connect to server group” checkbox

• Change Password tool nowwarns if current server is in group but not connected to group

• New setup option to reverse PTZ tilt operation

• New handling for server failover status codes

• Upgrade Bundles now checked before performing upgrades and warning issued if expired

• Significant performance improvements when connecting to large server groups and when reading
and writing configuration

• Various improvements to synchronising users in a server group, including when a mixture of version
5 and version 6 servers

• Fixed issue where configuration could report as ”locked” when adding ONVIF cameras

• Fixed issue with ad-hoc dewarping views not being saved in layouts correctly

• Fixed various issues with non-Latin characters in events and exports

• Fixed graphical issues on systems with no hardware OpenGL support

• Various minor GUI and setup fixes

• Display area no longer solos camera when double-clicked, it full-screens instead
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11 Version 6.6 Changes

11.1 Server Changes

• Support for manymore event cause types - see New Event Cause Types for more information.

• EVENTX command - support more event types

• Server event system support for ONVIF Topic string parameters

• Changes to Live Event Stream revamp to support new types

• New ”CopyTrack” functionality to allow recordings to be moved between storage devices

• Support Motion Search (Smart Search)

• New ”TCP-out” I/O protocol, providing support for new 3rd party integrations

• Various improvements to support a range of new Dell hardware

• New configurable connection timeout

• Added support for more bonded network interfaces

• Added support for Supermicro AOC-SAS2LP-MV8 disk controller

• Added support for various new Supermicro boards

• Fixed issue with Pelco encoder where channels wouldn’t restore after video loss

• Fixed issuewithUniviewcameras includingPullpointproblemsandONVIFStreamingoverHTTPwhen
port not 80

• Fixed Video Loss issue with Mobotix cameras

• Fixed issue with camera host names not working correctly

• Various other fixes and improvements

11.2 WaveView Changes

• New Motion Search function in Find screen

• Add support for new custom event causes in event rules setup page

• Updated live event stream to support new event types
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• New configurable connection timeout

• New option to restrict ”install” login IP address range

• Upgraded to latest Oncam SDK

• Improved audio synchronisation

• Various improvements to integration module selection and parameter entry

• Various fixes relating to saving dewarp views and exports

• New progress percentage output on the status bar for CopyTrack operations

• Fixed issue where sometimes the client would flash/flicker white in the Find screen

• Fixed issue where playback of recorded footage on a camera configured for dewarping appears jerky
sometimes

• Fixed issue with ”image authentication” failing for audio channels

• Several fixes in I/O device setup screen relating to integration modules

• Fixed issues configuring analogue spot monitor sequence using Stretch VRC7016LX spot outputs

11.3 More Information

11.3.1 Changes to motion sensitivity sliders

Prior to WaveView version 6.6 the motion detection sensitivity slider went from 0 to 255. During the v6.6
development it was determined that the sensitivity did not go low enough. Therefore the new scale is 0 to
1000. The old value of 255 will now display as 1000, but it is actually the same sensitivity. The old value of
0 will now be displayed as 745.

11.3.2 New Event Cause Types

The Wavestore now has new Event Cause types. Previous the list of available ”Event Causes” was a fixed
list. Now there are two extra ways in which new event cause types may appear.

• An ONVIF IP camera has sent an event of a type not seen previously by Wavestore.

• An integration module has been installed which defines new Event Cause types.

Note that well-defined ONVIF event types are alreadymapped to Wavestore types. For example, the ONVIF
event type for ”Motion” is already mapped to the Wavestore ”Motion” event cause.

Further information on this is in the latest Wavestore Manual.
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12 Version 6.4 Changes

12.1 Server Changes

• Support for interacting with LSI RAID cards via the WaveView Disks Setup Screen

• Syslog alarms for Multiple MegaRAID LSI RAID cards

• Software Support Agreements now enforced

• Email scripts now handle secure connections (e.g. SSL/TLS)

• Improved NVIDIA driver handling in graphics driver setup

• Added ”uifstats” command for getting network throughput statistics

• Added ”lspci” command as a way of listing hardware devices

• Added ”aplay” command as a way of listing audio devices

• Improvements to alog command - new ”-a” and ”-d” options

• Support for ONVIF Auxiliary commands

• Support for ONVIF JPEG/RTP Streaming extension

• Installer no longer automatically reboots at end of install process

• Automatic hardware configuration nowwrites a log message when run

• Support for operating system disks greater than 2 TeraBytes

• Notification protocol: Protocol D with time and timezone

• Disabled auto-carving for 3Ware cards since version 6 supports much higher storage capacity

• Added facility for deleting exports in maint menu when desktop not available

• Fixed issue with ONVIF RTSP/HTTP reconnections after network outage

• Fixed issue where ONVIF UDP could not be correctly configured

• Fixed issue where ONVIF Pullpoint streams wouldn’t always reconnect automatically

• Fixed issue where WaveView player not included when footage exported using local client

• Fixed issue where ”User agent” string said ”Wavestore/5.0” (ONVIF over HTTP)

• Fixed issue where Wavestore home page claimed to be version 5
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• Fixed issue where the recording indicator would flash when viewing a camera live with RTSP dual
streaming

• Fixed issues with log file rotation

• Fixed issue where xrandr tool could not be run

• Update kernel to provide mitigation of ”dirty cow” vulnerability

• Security improvements

12.2 WaveView Changes

• Support for interacting with LSI RAID cards via the WaveView Disks Setup Screen

• Major rewrite of display area and layout system including:

– Ability to switch video items between slots in a grid layout

– Ability to save more settings with layouts such as ”preserve aspect ratio”, ”contours and track-
ing”, and ”show subtitles”

– Ability to save resolution high/low for each display

– Ability to save audio mode setting for each item in the layout (Mute / Enable / Solo)

– Significant improvements to undo/redo operations for layouts

– Fixed issue with automatic layout loading at login

– Fixed issue where cameras would always switch to live when returning from full-screen

• Server field in login dialog is now auto-populated with ”localhost” on first boot after install

• Access to ONVIF Devices menu now denied for lower level users

• Experimental support for hardware accelerated decoding via NVIDIA CUDA

• Fixed issue where sometimes dewarped and panorama virtual camera presets weren’t saved in the
right position - see New dewarping serialisation format for more information.

• Fixed issue where server and cameras could be listed twice when opening WSB files

• Fixed autologin function for Linux client on server

• Fixed issue where files could not be deleted in WaveView file manager

12.3 More Information

12.3.1 New dewarping serialisation format

Prior to WaveView version 6.4 there were 4 different techniques for serialisation of dewarping settings:

• Wavestore V5 serialization

• Wavestore V6 serialization
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• Oncam serialization

• Immervision serialization

Investigations during the development of version 6.4 discovered a flaw in the Wavestore serialization tech-
niques whereby they could lose some information, resulting in saved dewarping views sometimes being
saved incorrectly.

Consequently from version 6.4 a new serialization technique ”V6_2” has been introduced whereby the val-
ues are saved correctly.

These serialization techniques have a number used to differentiate them. Wavestore v5 uses 0, Wavestore
v6 uses 1 and so on. This number is the first number seen in the venus config file under Camera_X->Lens
where the number is recorded in hexadecimal. So for example, if the view is recorded with V6 serialization
the data would begin with 01XXXXXXXXX...

When WaveView is under version 6.4 no views recorded with the ”V6_2” serialization can be seen, as the
software doesn’t recognize the number under Camera_X->Lens.

One drawback here is that if the user tries to add views on a camera that already uses ”V6_2” technique it
will have a black windowwhen clicking on the ”dewarped” or ”panoramic” buttons.

To fix this issue there are two possible work-arounds. The former (and recommended) is to download a
WaveView version >= 6.4, the latter is to click on ”Use Dewarping Options” to disable it, save and set new
views. However this will have the consequence of removing all views set with the new serialization tech-
nique.

12.3.2 New layout format

In version 6.4 it was decided that many improvements would be made to the way that layouts are saved
and loaded in order to make the feature more reliable as well as to addmore functionality.

Unfortunately it was not possible to maintain backwards compatibility so layouts created with version 6.2
and earlier are not viewable in version 6.4. Similarly, layouts created in version 6.4 are not viewable in
version 6.2 and earlier. Going forward however, the new layout system should be forwards and backwards
compatible from version 6.4 onwards.
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13 Version 6.2 Changes

13.1 Server Changes

• Support for Dual Streaming from supported ONVIF IP cameras

• New Auto Camera Setup for support ONVIF IP cameras

• Ability to loadmetadata protocol from file

• Integration modules now licence checked

• Improvement to sensor monitoring, supports IPMI and lm_sensors back-ends, better configurability

• Support for SES external disk enclosure monitoring

• System Drive SMART parameters nowmonitored

• Failover: ForceFail option for maintenance

• Integrationof LSI RAIDcards viaWavestore interfaceandstorcli, including syslogalarmsandhot-swap

• New ”clear-fault” exec script

• Added new ”Backup” capture type

• Corrected ONVIF identity string

• Various security improvements and bug fixes

13.2 WaveView Changes

• Integration module functions selectable from dropdown list

• Integration of Oncam Dewarping SDK.

• Integration of Immervision Dewarping SDK.

• Facility to upload audio files to server for playback on event

• Setup screens for network configuration of ONVIF devices

• Setup screens for ONVIF dual-streaming

• Support for dual-streaming resolution selection

• Newmethod for adding capture devices including improvements for adding ONVIF cameras
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• Various terms renamed to match industry standards

• Some improvements to layout handling

• Many improvements to I/O Devices Setup screen

• Positions of ’Add Column’ and ’Add Row’ buttons on Video Display Toolbar are fixed

• Enable/disable audio input and output in WaveView

• Upgraded Ampleye SDK

• New Linux software repositories for v6 WaveView on RedHat and Ubuntu systems

• Various security improvements and bug fixes

13.3 Known Issues

• There is an issuewith the ”undo layout” operationwhere it canneed tobeperformed twice toactually
perform the operation. This is due to be addressed in version 6.4.
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14 Version 6.0 Changes vs Version 5

14.1 Server Changes

• Major update to base operating system providing better hardware compatibility, performance, and
more.

• Major update to the LASS filesystem. See section 1.4.1 - New LASS Filesystem.

• N+1 failover support. See section 1.4.2 - Failover.

• NFS support in server (new DiskNames syntax).

• LASS6: disk nfs/cifs support in multiple files.

• Support for up to 32 network interfaces.

• New Alarm Board support (Axis VAPIX).

• Support for IPMI sensors to be inspected via SNMP.

• Support for multiple instances of WaveView client to be run, one per connectedmonitor.

• Identify Faulty Hard Drive.

• Various security updates including...

– SSH procedure changed.

– DVR Security: Privilege separation.

– Config file transmission now encrypted.

– Dropped support for old protocols for security reasons.

– No need to run as root.

– PASSWORD: password algorithmwith ”work-factor”.

– All users are forced to change password on first login.

• The installer nowworks from USB and has a more intelligent mechanism for determining which disk
the operating system should be installed to. See section 1.4.4 - Software Installer Changes.

• Multiple log files - EXEC command.

• Newmechanism for identifying audio devices.

• Support for opaque script files.
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14.2 WaveView Changes

• Major user interface update including...

– Updated icons and graphics.

– Dockable components in the main screen.

– Improved configurability of the live event streamwindow.

• New automatic login option.

• New option for automatic opening of layout upon login.

• New option for automatic full-screen on login.

• New Password Policy system.

• Arbitrary camera orientation/ wall angle for dewarping.

• New setup screen for LDAP/Active Directory.

• New setup screen for Failover. See section 1.4.2 - Failover.

• Many improvements to I/O Devices Setup Screen including ability to configure outputs via VAPIX.

• Improvements toNetworksetupscreen includingsupport fornetworkportbondingand jumbo frames.

• Improvements to Disks setup screen including ability to identify faulty hard drive.

• Support for InputSelect option for selecting analogue audio device input (e.g. Line or Mic).

• Newshortcut for opening cameras via keyboardnumpad (holdCtrl, thenpress ”/” followedby camera
number, then numpad Enter).

• Local settings now stored to file (”%USERPROFILE%\AppData\Roaming\Wavestore” on Windows,
”~/.config/Wavestore” on Linux).

14.3 Known Issues

• There is no publicly available Ubuntu client for 6.0.

• LASS volume usage percentage is not currently available in version 6 via the Disks Setup screen.
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15 Upgrade Process

The Upgrade Setup Screen (menu path View→ Setup→ Upgrade) allows the Wavestore server software to
be upgraded to the latest version.

Note: Upgrades will be applied to all connected servers in the server group and can be carried out from a
networked PC or laptop, or on the server itself, using the latest Wavestore install ISO.

If upgrading from a remote PC, it is recommended to update theWaveView software on that PC first, before
upgrading the servers.

To upgrade from an ISO file, the ISO first needs to be ”mounted” or written to a USB memory stick or DVD.
If the ISO is on a Windows PC, the easiest method is simply to mount the ISO. This is done by right-clicking
the ISO file and choosing ”Mount”. The ISO is then available as a separate disk (e.g. ”F:”), as if a pre-written
USB stick or DVD had been inserted.

If it is necessary to upgrade the Wavestore by connecting to it directly rather than from a remote client PC,
it will be necessary to write the ISO file to a USBmemory stick or DVD. OnWindows we recommend the use
of a program called Rufus. See section 15.3 - Writing an ISO with Rufus.

15.1 Performing the Upgrade

Before performing the upgrade, navigate to the Server setup screen (View→ Setup→ Server) and inspect
the ”Distribution” field. This is displayed on the ”General” tab which is the default.

If the distribution contains ”el7” rather than ”el7a” it is recommended to perform the upgrade twice. The
first upgrade will update the Wavestore software but not the operating system. The second will update the
operating system. This is only ever necessary once. Subsequent upgrades will only need to be performed
once.

If in doubt, performing the upgrade twice is sensible. If there is nothing to upgrade on the second pass it
will complete very quickly.
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Figure 15.1: Upgrade Server Screen

To perform the upgrade, first browse to the location of the upgrade file (’upgrade.txt’).
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Figure 15.2: Upgrade Server screen – browsing to locate ’upgrade.txt’ file

Once you have located the ’upgrade.txt’ file, select it then click on ’Open’.

The Select Upgrade File field will now show the upgrade file that you have chosen.

Click on ’Upgrade’, and the Information windowwill show progress of the upgrade, as the upgrade files are
copied across to the server:
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Figure 15.3: Upgrade Server screen – upgrade files being copied to the server

Once all the files have been checked and copied, the upgrade process will start. The system will tell you to
wait and this may take a fewminutes.

Whilst the upgrade takes place, recording continues. However once the upgrade is complete, the serverwill
eitherdoa software restart or a reboot, dependingonwhat is necessary to complete theupgrade. Obviously
recording is interrupted briefly at this time. Downgrades will always perform a reboot.
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Figure 15.4: Upgrade Server screen – upgrade completed

15.2 Potential Issues

If the upgrade fails, it will usually either show a failuremessage in the Upgrade screen, or amessage saying
”the upgrade completed without sending a status reply”.

In this case, gathering more information depends on the currently running version.

For version 6.14 or earlier, the System Log shows this information.

For version 6.16 or later, a more detailed log of the upgrade is available by following this procedure:

• Select Tools→ Execute Command...

• Run the command alog -a Upgrade

• Send this output to our support team for assistance

The possible errors are listed below with an explanation of what to do:

Upgrade failed: installing package XXX needs nMB on the / filesystem

Certain upgrades such as to v6.16 require a large amount of temporary space on the operating system
disk and those originally installed with an early version of Wavestore (version 6.10 or earlier) may not have
enough space to complete a full upgrade.
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It may be possible to free up space on the system using the file manager although this requires physical
access to the server. Using the client display on the server itself, move the mouse to the top-left of the
screen and a toolbar should drop down. Choose the icon which resembles a filing cabinet. If there are any
large files in there, deleting themmay free up enough space to complete the upgrade.

If the above steps do not work, it may not be possible to perform the operating system upgrade without a
re-installation. Re-installation requires being on-site and usually takes around 20 minutes. Performing the
re-installation creates a larger partition so that future upgrades do not have this issue.

SSDwearing out too fast

This message may appear in the log because some upgrades perform a large amount of writing to the op-
erating system disk. Unless you are going to do a full system upgrade every week, this is not a concern and
can be ignored, and the SSD will still last for many years.

Note that the message is a check on rate of wear, not an indication it is worn out. If you want to see how
much life left (in percentage terms), in WaveView go to Tools→ Execute Command and run the command
”ssd”.

15.3 Writing an ISO with Rufus

To install or upgradeWavestore from a USBmemory stick it is necessary to extract the ISO to the USB stick.
The way to do this depends on the Operating System. Most commonly MicrosoftWindows is used, in which
case the Rufus program is recommended.

Assuming the installation ISO has already been obtained, the process is as follows:

• On Windows, download Rufus from http://rufus.akeo.ie

• Run Rufus.

• Plug in the USB stick. Rufus should recognise the USB and populate the ”Device” box.

• On Rufus: ”Format Options”/”Create a bootable disk using” and select ”ISO Image”.

• On Rufus: click the icon to the right of the above text and select the ISO.

• On Rufus: click [Start] to start the write to USB.

• Select ”Write in ISO Image mode (recommended)” and click OK if Rufus asks about deleting files on
the USB stick.

• It’ll take a fewminutes to create the bootable USB.
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